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前言 

本文件描述在 VMware ESXi / VMware Workstation / Proxmox VE 部署及設定 N-Reporter 環境。 

 

※ 因異動 N-Reporter 系統將影響到授權，因此在進行重新部署或運用 vMotion / Live Migration 進行移轉，請先通 

知  N-Partner Support 遠端協助。 
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1. 前置準備 

1.1 請準備一台 Server，建議規格如下︰ 

✓ CPU 建議 E-2334 (8M 快取記憶體， 3.40 GHz) 以上。 

✓ RAM 記憶體 80GB 以上。 

✓ 硬碟空間 1TB 以上，請依實際需求決定。 

✓ 安裝 VMware ESXi 6.0 或以上的版本。 

✓ 安裝 Proxmox VE 7.0  或以上的版本。 

1.2 N-Reporter 運行時，若要達到最佳效能，至少需要 64G 以上的記憶體空間。 

1.3 請準備一台 Windows 電腦，用於管理 VMware / Proxmox VE。 

1.4 N-Reporter VM 建議 CPU 3.40GHz core x 8、RAM 記憶體 64G。
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(註 1) 

2. 下載 N-Reporter VMware image 

2.1 N-Reporter 提供多種 image，主要差別在於硬碟空間的使用量，功能沒有任何的差異。例如: N- 

Cloud7_Reporter_500G.ova，即表示安裝後，會有 500G 的資料儲存空間，加上系統空間128G，共需要

有628G硬碟空間。請依據實際需求下載合適的 Image 安裝。 

 
2.2 VMware 的版本 N-Reporter Image 下載地址如下壓縮檔 

https://www.npartner.com/download/vm/N-Cloud7_Reporter_500G.zip 

https://www.npartner.com/download/vm/N-Cloud7_Reporter_1T.zip 

https://www.npartner.com/download/vm/N-Cloud7_Reporter_2T.zip 

 

註 1: 若發生 VMware 配置 OVF 檔完畢後卻無法開機，編輯 N-Reporter VM 設定檔，勾選 Force BIOS (或開機時

按 F2) 進入 BIOS，配置 Hard Drive(0:0) 為第一優先開機裝置。 

註 2: 壓縮檔內含有 (VMware OVA 檔)  跟  OVA 檔的 (MD5 驗證碼檔)。請將下載的 zip 壓縮檔用解壓縮程式 (例 

如  7-Zip) 解壓縮。 

(註 2) 

https://www.npartner.com/download/vm/N-Cloud7_Reporter_500G.zip
https://www.npartner.com/download/vm/N-Cloud7_Reporter_1T.zip
https://www.npartner.com/download/vm/N-Cloud7_Reporter_2T.zip
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3. 安裝流程 

3.1 vSphere Client 

(1) 開啟 [VMware vSphere Client] -> 輸入 VMware IP address、User name、Password -> 按  [Login] 
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(2) 點選左上角 [File] -> [Deploy OVF Template...] 
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(3) [Source] 按  [Browse]  選擇匯入 N-Reporter OVA 檔案 -> 按  [Next] 
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(4) [OVF Template Details]  確認匯入 N-Reporter 資訊  -> 按  [Next] 
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(5) [Name and Location] 輸入虛擬機器名稱 -> 按  [Next] 
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(6) [Storage] 選擇 [存放的儲存空間] -> 按  [Next] 
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(7) [Disk Format] 選擇 [完整佈建消極式歸零(Thick Provision Lazy Zeroed)] 或  [完整佈建積極式歸零(Thick 

Provision Eager Zeroed)] -> 按  [Next]。完整佈建消極式歸零(Thick Provision Lazy Zeroed) 或 完整佈建積極式歸零 

(Thick Provision Eager Zeroed)  會給足硬碟完整大小。(註 3) 

 

註 3: 請勿使用精簡佈建(Thin Provision)格式，因為當 N-Reporter 虛擬機所在存儲裝置(datastore) 空間寫滿時，會 

造成系統無法運作，並且遺失資料。 
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(8) [Network Mapping] 選擇  [對應的網路] -> 按  [Next] 
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(9) 確認匯入資訊是否正確，勾選 [部署後開啟電源(Power on after deployment)] -> 按  [Finish]。開始部署虛擬機器 
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(10) 匯入完成後，點選 [N-Reporter 虛擬機器] -> 按  [啟動虛擬機器主控台(Launch Virtual Machine Console)] 
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(11) 預設 CLI 登入帳號密碼：npartner / npartner 
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(12) 查看 N-Reporter 設定 

 Reporter# show configure  
 

 
 
 

(13) 變更 N-Reporter IP address 

 
 

 

 

Reporter# configure terminal 

Reporter(config)# interface eth0 192.168.2.128 255.255.255.0 gw 192.168.2.253 

Reporter(config)# exit 

Reporter# show configure 

IP 設定方式︰ interface [interface] [N-Reporter_IP] [subnet_mask] gw [gateway_IP] 

紅色文字部位請輸入 N-Reporter IP address 
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3.2 vSphere Web Client 

(1) 開啟 [瀏覽器] -> 輸入 https://<VMware IP>、User name、Password -> 按  [Login] 
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(2) 點選 [建立/登錄虛擬機器] 
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(3) 選擇 [從  OVF 或  OVA 檔案部署虛擬機器] -> 按  [下一頁] 

 

 
(4) 輸入虛擬機器名稱 -> 點選 [N-Reporter OVA 檔案] -> 按  [下一頁] 
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(5) 選擇 [存放空間] -> 按  [下一頁] 
 

 

 
(6) 選擇 [對應的網路] -> 磁碟佈建(Disk provisioning)點選 [完整(Thick)] -> 按  [下一頁]。完整(Thick)會給足硬碟完

整大小。(註 4) 

 
 

 

註 4: 請勿使用精簡(Thin) 格式，因為當 N-Reporter 虛擬機所在存儲裝置(datastore) 空間寫滿時，會造成系統無法 

運作，並且遺失資料。 
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(7) 確認匯入資訊是否正確 -> 按  [完成]。開始部署虛擬機器 
 

 
(8) 匯入完成後，點選 [N-Reporter 虛擬機器] -> [按一下以開啟此虛擬機器的瀏覽器主控台] 
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(9) 預設 CLI 登入帳號密碼: npartner / npartner 
 

 

 
(10) 查看 N-Reporter 設定 

 Reporter# show configure  
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(11) 變更 N-Reporter IP address 

 
 

 
 

Reporter# configure terminal 

Reporter(config)# interface eth0 192.168.2.128 255.255.255.0 gw 192.168.2.253 

Reporter(config)# exit 

Reporter# show configure 

IP 設定方式︰ interface [interface] [N-Reporter_IP] [subnet_mask] gw [gateway_IP] 

紅色文字部位請輸入 N-Reporter IP address 
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3.3 VMware Wortstation 

(1) 開啟 [VMware Workstation] 
 

 

 
(2) 點選左上角 [File] -> [Open...] 
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(3) 選擇匯入 N-Reporter OVA 檔案 -> 按  [開啟] 
 

 
 

(4) 輸入虛擬機器名稱 -> 選擇  N-Reporter VM 儲存路徑 -> 按  [Import] 



26 

 

 

 

(5) 選擇 N-Reporter VM -> 點選 [Edit virtual macine settings] 
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(6) 檢查 [Network Adapter] -> 勾選 [Connect at power on] 和  [Bridged] 模式 
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(7) 點選 [USB Controller] -> 按  [Remove] 
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(8) 按  [OK] 
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(9) 按  [Power on this virtual machine] 

 

 
 

(10) 預設 CLI 登入帳號密碼：npartner / npartner 
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(11) 查看 N-Reporter 設定 

 Reporter# show configure  

 

 
(12) 變更 N-Reporter IP address 

 
 

 

Reporter# configure terminal 

Reporter(config)# interface eth0 192.168.2.128 255.255.255.0 gw 192.168.2.253 

Reporter(config)# exit 

Reporter# show configure 

IP 設定方式︰ interface [interface] [N-Reporter_IP] [subnet_mask] gw [gateway_IP] 

紅色文字部位請輸入 N-Reporter IP address 
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3.4 Proxmox VE 7 
 

(1) 登入 [Proxmox VM] -> 按  [Create VM] 
 

 

 
(2) [一般]  頁面；選擇 [PVE 節點] -> 輸入 VM ID: 和  VM 名稱: N-Reporter -> 按  [繼續] 
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(3) [作業系統]  頁面；點選 [不要使用任何媒體] -> 選擇客體作業系統類別: [Linux] -> 版本: [5.x - 2.6 Kernel] -> 按 

[繼續] 
 



34 

 

 

 

(4) [系統]  頁面；選擇 SCSI 控制器: [VirtIO SCSI] -> 按  [繼續] 
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(5) [磁碟]  頁面；選擇匯流排/裝置: [SCSI] -> 按  [繼續] 
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※核心總數 8 以上 

 

(6) [CPU] 頁面；輸入插槽: 和核心: -> 按 [繼續] 
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※至少 64GiB 以上 

 

(7) [記憶體] 頁面；輸入記憶體 (MiB): 65536   -> Ballooning裝置取消勾選 -> 按 [繼續] 
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※依據客戶環境輸入 VLAN Tag 

 

(8) [網路] 頁面；選擇橋接: VMbridge -> 型號: [Intel E1000] -> 按 [繼續] 
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(9) [確認]  頁面；查看 VM 配置  -> 按  [完成] 
 

 

 
(10) 點選 [N-Reporter VM] -> [硬體] -> [硬碟] -> 按  [中斷連結] 
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(11) 按  [是] 
 

 

 
(12) 點選 [未使用的磁碟] -> 按  [移除] 

 

 
 

(13) 按  [是] 
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(14) 點選 [CD/DVD 裝置] -> 按  [移除] 
 

 
 

(15) 按  [是] 
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(16) 顯示 N-Reporter VM 硬體訊息 
 

 

 

(17) 查看 KVM 版本 

 # qemu-img --version  
 

 
 
 

(18) 將  Disk1 vmdk 檔轉換成 qcow2 檔 

 # qemu-img convert -f vmdk N-Cloud7_Reporter_500G_7.0.005-disk1.vmdk -O qcow2 N-Reporter-dom.qcow2  

 

(19) 將  Disk2 vmdk 檔轉換成 qcow2 檔 

# qemu-img convert -f vmdk N-Cloud7_Reporter_500G_7.0.005-disk2.vmdk -O qcow2 N-Reporter-data.qcow2 

 
 

使用解壓縮軟體將 N-Reporter OVA 解開，並將 N-Reporter disk1.vmdk、disk2.vmdk 檔案傳送到 Proxmox VE 
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(20) 查看轉換 qcow2 檔案格式 

 # qemu-img info N-Reporter-dom.qcow2  
 

 

# qemu-img info N-Reporter-data.qcow2                                                                                                                    
 

 
 

(21) 匯入 QCOW2 磁碟至 N-Reporter 虛擬機器 

 # qm importdisk 133 N-Reporter-dom.qcow2 local-zfs -format qcow2  
 

 

 

 

# qm importdisk 133 N-Reporter-data.qcow2 local-zfs -format qcow2  
 

 

 
qm importdisk <vmid> <source> <storage> --format qcow2 
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(22) 選擇 [N-Reporter VM] -> 點選 [硬體] -> [未使用的磁碟0] -> [編輯] 
 

 
 

(23) [磁碟]  頁面；點選匯流排/裝置: [SCSI] -> 查看 [磁碟映像]  存放位置 -> 按  [增加] 
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(24) 選擇 [N-Reporter VM] -> 點選 [硬體] -> [未使用的磁碟1] -> [編輯] 
 

(25) [磁碟]  頁面；點選匯流排/裝置: [SCSI] -> 查看 [磁碟映像]  存放位置 -> 按  [增加] 

(26) 硬體詳細資訊 

確認disk 0(128G)為系統硬碟，disk1為資料硬碟。 
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(27) 點選 [選項] -> [開機順序] -> [編輯] 

 

 
 

(28) 勾選 [啟用硬碟裝置 N-Reporter disk0 128G ] 移動到最上層 -> 按  [完成] 
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(29) 點選 [>_ 主控台] -> 按  [Start Now] 
 

 
 

(30) 預設 CLI 登入帳號密碼: npartner / npartner 
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(31) 查看 N-Reporter 設定 

 Reporter# show configure  
 

 
 
 

(32) 變更 N-Reporter IP address 

 
 

 

 

Reporter# configure terminal 

Reporter(config)# interface eth0 192.168.3.1 255.255.254.0 gw 192.168.3.254 

Reporter(config)# exit 

Reporter# show configure 

IP 設定方式︰ interface [interface] [N-Reporter_IP] [subnet_mask] gw [gateway_IP] 

紅色文字部位請輸入 N-Reporter IP address 
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4. 更新流程 

4.1 License update 

(1) 開啟 [瀏覽器] -> URL 輸入 https://<N-Reporter IP>，連上 N-Reporter License 頁面，按 [Get Machine Key] 
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(2) 下載 machine.dat 。將  machine.dat 寄給 se@npartnertech.com 

 

 
 

請依底下圖示的郵件格式撰寫 

 

郵件格式 

主旨：N-Reporter License 測試申請 

郵件內容：

公司名稱：

申請人： 

電子郵件： 

連絡人電話： 

服務的經銷商或 SI 廠商：（可空白）

備註： 

mailto:se@npartnertech.com
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(3) 取得 license.np 檔案，請再次連上 https://<N-Reporter IP>。按 [Upload License] -> 按  [瀏覽]  選取 license.np 

檔案 -> 按  [Upload] 
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(4) 此時，系統會自動重新開機。 
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(5) 重新開機後，連上 N-Reporter 登入頁面。輸入後台帳號密碼 -> 按下 [登入] 

(預設的 Web 前台登入帳號密碼：admin / admin , 預設的 Web 後台登入帳號密碼: superuser / admin) 

 
 

(6) 確認 License 狀態 
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4.2 Firmware upgrade 
 

4.2.1 WEB 

 
(1) 開啟 [瀏覽器] -> URL 輸入  https://<N-Reporter IP> -> 輸入後台帳號密碼按  [登入] 

 (預設的 Web 前台登入帳號密碼：admin / admin , 預設的 Web 後台登入帳號密碼: superuser / admin) 
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(2) 按  [上傳軟體更新檔] 

 

 

 
(3) 按  [瀏覽] -> 選  Firmware image 檔案 -> 按  [匯入] 
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(4) 確認系統韌體上傳成功訊息，等待三分鐘系統自動刷新網頁 

 

 
(5) 確認韌體版本 
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4.2.2 CLI 

 
使用 ssh 連線工具(Xshell 或  SecureCRT) -> 輸入 N-Reporter IP -> 輸入 CLI 帳號密碼 

(預設的 CLI 登入帳號密碼：npartner / npartner) 

 
 

 

(1) 顯示目前韌體版本 

 Reporter# show version  

 
 
 

(2) 韌體更新 

 Reporter# system image upgrade  

 

 
(3) 確認要更新 image 

Do upgrade system image ? y 
 

 

 

 
(4) 使用 ssh 連線軟體須支援 ZMODEM 協定 

Going to receive image via zmodem. y 
 

 
 

(5) 使用 XShell 連線軟體須按 y，本範例使用 SecureCRT 連線軟體按 n 
 

 

※ 系統不支援 ZMODEM 傳輸功能的 ssh Client，例如 Putty 

若使用 XShell 做為 ssh Client，必須回答 Y ，否則傳輸將會停住。 
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(6) 選取 Firmware image -> [開啟] 

 

 
 

(7) 顯示傳檔訊息 -> 顯示 image 更新完成 Verifying upload image ... OK 
 

 

 
(8) 顯示更新韌體版本 

 Reporter# show version  

 
 
 

(9) 檢查系統更新狀態 

 Reporter# system check  
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4.3 Kernel upgrade 

使用 ssh 連線軟體(Xshell 或  SecureCRT) -> 輸入 N-Reporter IP -> 輸入 CLI 帳號密碼 

(預設的 CLI 登入帳號密碼：npartner / npartner) 

 
 

 

(1) 顯示目前 kernel 版本 

 Reporter# show version  

 
 

 
(2) 更新 Kernel 

 Reporter# system kernel upgrade  

 

 
(3) 確認要更新 Kernel 

Do upgrade kernel ? y 

 
 
 

(4) 使用 ssh 連線軟體須支援 ZMODEM 協定 

Going to receive kernel via zmodem. y 
 

 

 
(5) 使用 XShell 連線軟體須按 y，本範例使用 SecureCRT 連線軟體按 n 

 

 

※ 系統不支援 ZMODEM 傳輸功能的 ssh Client，例如 Putty 

若使用 XShell 做為 ssh Client，必須回答 Y ，否則傳輸將會停住。 
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(6) 選取 np_Kernel.npz 檔案  -> 按  [Add] -> [OK] 

 

 
(7) 顯示傳檔訊息 

 

 
(8) 確認 MD5 檢驗碼一致按 y -> 顯示 kernel 更新完成 kernel Upgrade done 

 

 

 
(9) 檢查系統更新狀態 

 
 

 

※ 執行  system check (6.1.081 之後版本)  若出現底下圖片，須立即連絡 N-Partner Support 處理 

Reporter# system check 
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(10) 重新開機 

 Reporter# reboot  
 

 
 
 

(11) 重新開機後，顯示更新韌體版本 

 Reporter# show version  
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5. 啟用 N-Probe 

5.1 N-Probe 

透過終端機模擬軟體 (例如︰Putty、SecureCRT、XShell 等) 以  SSH 連線到 N-Reporter / N-Cloud 命令列介面 

(CLI) (預設的 CLI 登入帳號密碼：npartner / npartner) 

(1) 查看設定檔 

 Reporter# show configure  
 

 
 
 

(2) 進入設定模式 

 Reporter# configure terminal  

(3) 啟動 Probe 功能 

 Reporter(config)# probe on  

(4) 設定 Flow 流量輸出到 N-Reporter 接收 IP 與  Port 

 Reporter(config)# flow-export 192.168.2.77 9001  

(5) 設定 Flow sampling rate，每一個封包擷取一個 sample 

 Reporter(config)# flow-sampling 1  

(6) 啟用 IPv6 Flow traffic 監聽封包 

 Reporter(config)# flow-ipv6 on  

(7) 設定 probe interface N 個接聽介面，本範例啟用一個介面。 

 Reporter(config)# probe interface 1  

(8) 離開 config mode 

 Reporter(config)# exit  
 

紅色文字部位請輸入 N-Reporter IP address 
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(9) 確認設定完成 

 Reporter# show configure  
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5.2 VMware ESXi Network 

5.2.1 vSphere Client 

(1) 登入 VMware ESXi 

開啟 [VMware vSphere Client] -> 輸入 VMware IP address、User name、Password -> 按  [Login] 
 



65 

 

 

 

(2) 開啟虛擬交換器 

點選 [VMware ESXi host] -> [Configuration] 頁面 -> [Networking] 項目 -> vSwitch: [Properties] 
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(3) 編輯網路設定 

選擇 [VM Network] -> 按  [Edit] 
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(4) 啟用混合模式 

點選 [Security]  頁面 -> 勾選  [Promiscuous Mode:] 選擇 [Accept] -> 按  [OK] 
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5.2.2 vSphere Web Client 

(1) 登入 VMware ESXi 

開啟 [瀏覽器] -> URL 輸入  https://<VMware IP> -> 輸入使用者名稱和密碼 -> 按  [登入] 
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(2) 編輯網路設定 

點選 [網路] -> [連接埠群組]  頁面 -> 選擇 [VM Network] -> 點選 [編輯設定] 
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(3) 啟用混合模式 

展開 [安全性] -> 點選混合模式: [接受] -> 按  [儲存] 
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5.3 KVM 

5.3.1 Proxmox VE 7 

(1) 點選 [PVE node] -> [系統] -> [網路] -> [建立] -> [Linux Bridge] 
 

 
 

(2) 輸入橋接連接埠: enp1s0f0 ※請依客戶環境輸入未使用 Interface Port -> 輸入註解: Port Mirror -> 按  [建立] 
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(3) 按  [套用設定] 
 

 

 
(4) 按  [是] 

 

 

 
(5) 顯示 Linux Bridge 套用情形 
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※請依據客戶環境 

 

(6) 切換到 [>_ 命令列] -> 編輯  interface 輸入 nano /etc/network/interfaces 
 

 
 
 

(7) 在 iface vmbr1 新增一行 bridge_ageing 0 -> 按 [Ctrl] + [O] 存檔 -> 再按 [Ctrl] + [X] 離開 
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※請依客戶環境選擇 Mirror Bridge 

(8) ※重啟網卡可能會影響 PVE 設備網路，輸入 systemctl restart networking && systemctl status networking 
 

 
 

(9) 選擇 N-Reporter VM -> [硬體]  項目 -> 按  [新增] -> 點選 [網路裝置] 
 

 
 

(10) 選擇 Mirror Bridge: [vmbr1] -> Model: [Intel E1000] -> 按 [Add] 
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(11) 顯示 N-Reporter VM 硬體訊息 
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6. 問題排除 

6.1 End of Ova File Reached While Looking 

若在 ESXi 部署 OVA 時,  出現底下無法部署的錯誤訊息時,  可以採用其他方式進行部署 OVA 的動作。 
 

 

 

6.1.1 採用  ESXi Web Client 的操作方式部署 OVA 

參考 3.2 vSphere Web Client 步驟 
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6.1.2 使用  VMware OVF Tool 的方式部署 OVA 

(1) 前往網址 https://code.vmware.com/web/tool/4.3.0/ovf 

下載 [VMware Open Virtualization Format Tool (ovftool)] 版本，範例︰ovftool - 4.3.0 Patch 1 
 

 

 
(2) 安裝 OVFTool 

點擊 [VMware-ovftool-4.3.0-14746126-win.x86_64.msi] -> 按  [Install] 到  [Finish] 
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(3) 開啟 [Windows PowerShell] 
 

 

 
(4) 切換到 VMware OVF Tool 資料夾 

 PS C:\> cd 'C:\Program Files\VMware\VMware OVF Tool\'  
 

 
 
 

(5) 使用 OVF Tools 匯入 N-Reporter OVA 指令，參數︰--name 虛擬機名稱，--diskMode 磁碟模式 thick 完整佈

建，--datastore 儲存區名稱 

 

輸入 VMware Password: 
 

 

 

紅色文字部位請輸入 N-Reporter OVA 路徑及檔名 

D:\N-Cloud7_Reporter_500G_v7.0.005.ova 

紅色文字部位請輸入 VMware 帳號和 IP address 

vi://root@192.168.2.46/ 

PS C:\> .\ovftool.exe --acceptAllEulas --noSSLVerify --name=N-Reporter --diskMode=thick --datastore=datastore1 – 
net D:\N-Cloud7_Reporter_500G_v7.0.005.ova vi://root@192.168.2.46/ 
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(6) 登入 VMware ESXi 主機，即可看到 OVF Tool 部署的 N-Reporter VM。 
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6.2 Larger Than the Maximum Size Supported by Datastore 
https://docs.vmware.com/en/VMware-vSphere/5.5/com.vmware.vsphere.storage.doc/GUID-D01AFDA9-B04D-

4910- 804B-0A1E73DA6BE4.html 

 

 

(1) 大小超過資料存放區 VMFS3 支援的大小上限 
 

 

 

(2) [Configuration] tab -> [Storage] -> [Upgrade to VMFS-5] 
 

 
 

(3) Click [OK] to start the upgrade. 
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(4) Perform a [Rescan All] hosts that are associated with the datastore. 
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6.3 The OVF Package is Invalid and Cannot Be Deployed 

https://kb.vmware.com/s/article/2151537 
 

(1) vSphere Client 不支援 SHA256 哈希算法 

 
(2) 開啟 [Windows PowerShell] 

 

 

 
(3) 切換到 VMware OVF Tool 資料夾 

 PS C:\> cd 'C:\Program Files\VMware\VMware OVF Tool\'  
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(4) 使用 OVF Tools 將  N-Reporter OVA 從  SHA256 轉換成 SHA1 

 PS C:\> .\ovftool.exe --shaAlgorithm=SHA1 D:\Reporter7_2T_7.0.005.ova D:\Reporter7_2T_7.0.005-sha1.ova  
 

 

紅色文字部位請輸入來源 N-Reporter OVA 路徑檔名及目的地 N-Reporter OVA 路徑檔名 

D:\Reporter7_2T_7.0.005.ova D:\Reporter7_2T_7.0.005-sha1.ova  
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6.4 Workstation Device/Credential Guard Not Compatible 

https://kb.vmware.com/s/article/2146361 

(1) 原因是 Device Guard 或  Credential Guard 與  Workstation 不相容 
 

 
 

(2) 開啟 [Windows PowerShell] 
 

 

 
(3) 關閉 Hyper-V 

 PS C:\> bcdedit /set hypervisorlaunchtype off  

 
 

(4) 重新開機 

 PS C:\> Restart-Computer  

 

 

https://kb.vmware.com/s/article/2146361
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